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LAMPIRAN 

 

Lampiran 1. Daftar Terjemah 

No BAB Kutipan Halaman Terjemah 

1 I Q.S Al-A’laq 96: 1-

5. 

2 (1) Bacalah dengan (menyebut) 

nama Tuhanmu yang 

menciptakan, 

(2) Dia telah menciptakan 

manusia dari segumpal 

darah. 

(3) Bacalah, dan Tuhanmulah 

Yang Maha Mulia. 

(4) Yang mengajar (manusia) 

dengan pena. 

(5) Dia mengajarkan manusia 

apa yang tidak 

diketahuinya. 

2 I Mrinal Sarma dan 

Majidul Ahmed, “A 

Study on the Difficulty 

of Teaching and 

Learning Mathematics 

in Under Graduate 

Level with Special 

Reference to Guwahati 

City”. 

5 Matematika adalah studi 

tentang kuantitas, struktur dan 

perubahan (yaitu aritmatika, 

aljabar, geometri & analisis). 

3 I Mark H. Ashcraft, 

“Math Anxiety: 

Personal, Educational, 

and Cognitive 

Consequences”. 

5 Kecemasan matematika 

umumnya didefinisikan sebagai 

perasaan tegang, khawatir, atau 

takut yang mengganggu kinerja 

matematika. 

4 II Bower, G.H, “Theories 

of Learning”. 
23 Meskipun sulit untuk 

membingkai definisi 

pembelajaran yang memadai 

untuk mencakup semua bentuk 

yang beragam dan 

mengecualikan penyebab lain 

dari perubahan perilaku, definisi 
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No BAB Kutipan Halaman Terjemah 

    pembelajaran itu sendiri 

bukanlah sumber utama 

perbedaan antara teori-teori 

pembelajaran. Perbedaan 

mereka adalah interpretasi, 

bukan definisi. 

5 II Gina Gresham, “A 

Study Exceptional 

Education Pre-service 

Teachers’ 

Mathematics Anxiety”. 

27 Ketidakberdayaan dan 

kepanikan yang dialami 

seseorang ketika diminta untuk 

melakukan matematika. 

6 II Gina Gresham, “A 

Study Exceptional 

Education Pre-service 

Teachers’ 

Mathematics Anxiety”. 

28 Sindrom “Saya tidak bisa” 

kecemasan matematika dapat 

disebabkan dari satu 

pengalaman matematika yang 

memalukan atau karena 

kurangnya pemahaman terapan 

dan penerapan konsep 

matematika. 

7 II Xinbing Luo dkk, 

“Investigation and 

Analysis of 

Mathematics Anxiety 

in Middle School 

Students”. 

30 Kecemasan matematika adalah 

sejenis penyakit. Ini adalah 

suasana hati yang pasif secara 

kognitif yang dihasilkan oleh 

matematika. 
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Lampiran 2. Angket Kecemasan Matematika 
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Lampiran 3. Tabulasi Angket Kecemasan Matematika 

No Nama Q1 Q2 Q3 Q4 Q5 Q6 Q7 Q8 Q9 Q10 Q11 Q12 Q13 Q14 Q15 Q16 Q17 Q18 Q19 Q20 Q21 Q22 

1 CLANISSIA SUCI 

FATHANA 
1 2 2 3 2 4 3 4 2 2 2 3 3 3 2 2 2 2 3 3 2 2 

2 FITRIATI 1 2 1 2 1 3 3 3 1 1 1 3 3 3 3 1 3 1 3 3 3 1 

3 MUHAMMAD 

RIDHO 
3 2 2 3 3 3 2 4 2 1 3 3 4 5 2 1 3 1 5 4 2 2 

4 MUSLIMATUR 

RAHMAH 
1 3 4 2 2 4 3 3 1 1 2 3 4 3 1 3 3 1 4 5 3 2 

5 NADIA KHAIFA 1 2 4 3 1 4 2 4 2 1 2 3 3 2 3 2 3 1 3 4 2 2 

6 NORFUJIYAH 2 3 2 4 2 3 3 4 2 2 2 3 3 3 2 2 3 3 3 3 3 2 

7 NORSYIFA 1 3 4 3 2 3 2 3 2 1 1 3 3 3 2 2 1 1 3 3 1 2 

8 NUR HASANAH 1 2 3 3 2 3 3 2 1 1 1 2 3 2 2 2 1 2 2 2 2 2 

9 RAHMATULLAH 1 1 1 3 1 1 1 1 1 1 1 3 1 2 1 1 1 1 1 3 4 1 

10 SITI JAINAP 1 1 3 3 1 1 2 1 1 1 1 3 3 1 1 3 1 1 3 3 2 1 

11 WANDA PUJI 

KUSUMA 

WARDANI 

1 2 2 2 3 4 3 3 1 1 2 3 4 3 2 2 2 1 4 4 3 3 

12 ZAHRATUL 

MAHFUZAH 
1 2 3 2 1 5 2 3 1 1 2 2 3 2 2 1 3 1 3 2 2 2 

13 AINUN ASYIFA 2 2 2 2 1 2 4 2 2 1 1 4 2 4 1 1 1 1 4 2 2 1 

14 ANNISA AHLA 1 2 2 2 3 4 3 3 1 1 2 3 4 3 2 2 2 1 4 4 3 3 

15 DEWI DESIANA 

ROHMAWATUL 

SAFITRI 
2 3 3 3 1 5 4 4 2 3 3 5 4 5 3 5 2 2 5 4 3 3 

16 HAFIZATUL 

AZMI 
2 3 3 3 1 3 3 3 2 1 2 2 3 4 2 2 3 1 3 3 2 2 
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No Nama Q1 Q2 Q3 Q4 Q5 Q6 Q7 Q8 Q9 Q10 Q11 Q12 Q13 Q14 Q15 Q16 Q17 Q18 Q19 Q20 Q21 Q22 

17 IMELDA SAVIRA 

MALIK 
1 2 3 3 3 2 1 2 1 1 1 3 4 2 2 2 1 1 1 2 4 4 

18 MUHAMMAD 

IMAN ANSYARI 
1 1 5 3 1 4 4 3 1 1 1 3 3 2 1 1 2 1 2 3 1 2 

19 MUHAMMAD 

TAZKIAT 

ALHAYTSAM 

1 1 3 3 1 1 1 1 1 1 1 1 3 1 1 1 1 1 1 1 1 1 

20 NASRIN 1 2 3 2 1 4 2 4 1 1 2 4 4 4 2 2 2 1 2 4 2 1 

21 NURUL FAIZAH 2 3 5 5 3 4 5 4 2 2 2 4 5 4 3 3 2 2 3 4 2 3 

22 SITI LIANI 1 2 2 3 1 2 2 2 2 2 1 3 3 3 1 1 2 1 4 3 3 2 

23 SUMAYYAH 2 3 3 3 2 3 2 3 2 2 2 3 3 3 2 3 2 2 3 3 3 2 

24 SUSILAWATI 1 1 2 3 1 1 2 2 1 1 1 3 3 2 2 2 2 3 2 2 3 1 

25 ZAINUL GANI 1 2 3 3 1 2 2 3 2 1 1 3 2 1 1 3 1 1 3 2 3 2 

 TOTAL PER 

INSTRUMEN 
33 52 70 71 41 75 64 71 37 32 40 75 80 70 46 50 49 34 74 76 61 49 
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No Nama Q23 Q24 Q25 Q26 Q27 Q28 Q29 Q30 Q31 Q32 Q33 Q34 Q35 

1 CLANISSIA SUCI 

FATHANA 
3 3 3 4 2 4 4 3 3 3 4 3 2 

2 FITRIATI 2 3 3 5 4 3 3 2 3 2 3 3 3 

3 MUHAMMAD 

RIDHO 
2 4 3 2 2 4 2 2 4 4 2 1 2 

4 MUSLIMATUR 

RAHMAH 
3 3 3 3 4 5 4 4 3 3 3 3 3 

5 NADIA KHAIFA 2 3 3 3 2 4 4 3 3 3 3 3 3 

6 NORFUJIYAH 3 3 3 2 2 3 3 4 3 3 2 2 2 

7 NORSYIFA 2 2 2 4 2 4 3 3 3 3 2 2 2 

8 NUR HASANAH 2 3 3 2 3 4 3 3 3 3 4 3 2 

9 RAHMATULLAH 1 1 1 1 1 5 3 1 1 1 5 1 1 

10 SITI JAINAP 1 3 3 2 2 3 2 3 2 3 4 4 1 

11 WANDA PUJI 

KUSUMA 

WARDANI 

3 3 3 1 4 4 4 4 4 3 3 3 1 

12 ZAHRATUL 

MAHFUZAH 
2 3 2 2 2 4 4 3 4 4 3 3 3 

13 AINUN ASYIFA 2 2 2 2 1 1 2 4 2 4 5 4 4 

14 ANNISA AHLA 3 3 3 1 4 4 4 4 4 3 3 3 1 

15 DEWI DESIANA 

ROHMAWATUL 

SAFITRI 

3 4 4 5 2 5 5 5 3 5 5 5 4 

16 HAFIZATUL 

AZMI 
1 3 2 4 4 4 4 4 3 3 2 2 4 

17 IMELDA SAVIRA 

MALIK 
1 2 2 4 3 4 3 3 4 2 5 5 3 

18 MUHAMMAD 

IMAN ANSYARI 
2 4 3 2 2 3 4 4 1 4 1 1 2 

19 MUHAMMAD 

TAZKIAT 

ALHAYTSAM 

1 1 1 5 1 5 4 4 3 2 2 2 1 

20 NASRIN 3 4 4 5 4 5 4 4 2 4 4 4 4 

21 NURUL FAIZAH 3 4 4 5 4 5 5 4 5 4 5 5 4 

22 SITI LIANI 2 3 2 2 3 2 3 3 2 3 1 4 1 

23 SUMAYYAH 2 3 3 4 3 3 3 3 3 3 4 4 2 

24 SUSILAWATI 1 3 3 4 3 3 4 3 3 3 2 2 1 

25 ZAINUL GANI 2 2 2 2 2 2 3 3 1 3 1 1 1 

 TOTAL PER 

INSTRUMEN 
52 72 67 76 66 93 87 83 72 78 78 73 57 
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Lampiran  4. Rekapitulasi Angket Kecemasan Matematika 

SKALA LIKERT SS S N TS STS 

POSITIF 5 4 3 2 1 

NEGATIF 1 2 3 4 5 

 

No Cap Waktu Nama NIM Kelas 
Q1 Q2 Q3 Q4 Q5 Q6 Q7 Q8 Q9 Q10 Q11 Q12 Q13 Q14 Q15 Q16 Q17 Q18 

P N P N N P N P P N P P N P P N P N 

1 

2021/05/31 

1:45:40 
PM 

GMT+8 

Siti Liani 200101040756 
PMTK 
B 2020 

STS S TS N SS TS S TS TS S STS N N N STS SS TS SS 

2 

2021/05/31 
2:01:13 

PM 

GMT+8 

Hafizatul 

Azmi 
200101040796 

PMTK 

B 2020 
TS N N N SS N N N TS SS TS TS N S TS S N SS 

3 

2021/05/31 
2:24:14 

PM 
GMT+8 

Nadia 

Khalifa 
200101040411 

PMTK 

A 2020 
STS S S N SS S S S TS SS TS N N TS N S N SS 

4 

2021/05/31 

5:14:52 

PM 
GMT+8 

Muslimatur 

Rahmah 
200101040241 

PMTK 

A 2020 
STS N S S S S N N STS SS TS N TS N STS N N SS 

5 

2021/06/08 

2:45:27 
PM 

GMT+8 

Muhammad 

Tazkiat 

Alhaytsam 

200101040635 
PMTK 
B 2020 

STS SS N N SS STS SS STS STS SS STS STS N STS STS SS STS SS 

6 

2021/06/08 

2:46:33 
PM 

GMT+8 

Wanda Puji 

Kusuma 

Wardani 

200101040656 
PMTK 
A 2020 

STS S N N N N N S STS SS TS N N TS TS S STS S 

7 

2021/06/08 

2:47:47 

PM 

GMT+8 

Annisa 

Ahla 
200101040779 

PMTK 

B 2020 
STS S TS S N S N N STS SS TS N TS N TS S TS SS 
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No Cap Waktu Nama NIM Kelas 
Q1 Q2 Q3 Q4 Q5 Q6 Q7 Q8 Q9 Q10 Q11 Q12 Q13 Q14 Q15 Q16 Q17 Q18 

P N P N N P N P P N P P N P P N P N 

8 

2021/06/08 
2:56:03 

PM 

GMT+8 

Zainul Gani 200101040622 
PMTK 

B 2020 
STS S N N SS TS S N TS SS STS N S STS STS N STS SS 

9 

2021/06/08 

3:14:09 

PM 
GMT+8 

Nasrin 200101040799 
PMTK 

B 2020 
STS S N S SS S TS S STS SS TS S TS S TS S TS SS 

10 

2021/06/08 

7:30:51 

PM 
GMT+8 

Nurul 

Faizah 
200101040743 

PMTK 

B 2020 
TS N SS STS N S STS S TS S TS S STS S N N TS TS 

11 

2021/06/08 

8:10:15 
PM 

GMT+8 

Zahratul 
Mahfuzah 

200101040406 
PMTK 
A 2020 

STS S N S SS SS S N STS SS TS TS N TS TS SS N TS 

12 

2021/06/08 
8:11:39 

PM 

GMT+8 

Muhammad 

Ridho 
200101040396 

PMTK 

A 2020 
N S TS N N N S S TS SS N N TS SS TS SS N SS 

13 

2021/06/08 
8:13:04 

PM 

GMT+8 

Rahmatullah 200101040108 
PMTK 

A 2020 
STS SS STS N SS STS SS STS STS SS STS N TS SS TS STS SS STS 

14 

2021/06/08 

8:19:48 

PM 
GMT+8 

Norfujiyah 200101040210 
PMTK 

A 2020 
TS N TS TS S N N S TS S TS N N N TS S N N 

15 

2021/06/08 

8:22:01 

PM 
GMT+8 

Nur 

Hasanah 
200101040175 

PMTK 

A 2020 
STS S N N S N N TS STS SS STS TS N TS TS S STS S 

16 

2021/06/08 

8:24:18 
PM 

GMT+8 

Clanissia 

Suci 

Fathana 

200101040153 
PMTK 
A 2020 

STS S TS N S S N S TS S TS N N N TS S TS S 
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No Cap Waktu Nama NIM Kelas 
Q1 Q2 Q3 Q4 Q5 Q6 Q7 Q8 Q9 Q10 Q11 Q12 Q13 Q14 Q15 Q16 Q17 Q18 

P N P N N P N P P N P P N P P N P N 

17 

2021/06/08 
8:25:58 

PM 

GMT+8 

Norsyifa 200101040359 
PMTK 

A 2020 
STS N S N S N S N TS SS STS N N N TS S STS SS 

18 

2021/06/08 
8:33:25 

PM 

GMT+8 

Fitriati 200101040015 
PMTK 

A 2020 
STS S STS S SS N N N STS SS STS N N N N SS N SS 

19 

2021/06/08 

8:33:49 

PM 
GMT+8 

Muhammad 
Iman 

Ansyari 

200101040279 
PMTK 

B 2020 
STS SS SS N SS S TS N STS SS STS N N TS STS SS TS SS 

20 

2021/06/08 

8:39:48 
PM 

GMT+8 

Sumayyah 200101040498 
PMTK 
B 2020 

TS N N N S N S N TS S TS N N N TS N TS S 

21 

2021/06/08 

8:41:44 
PM 

GMT+8 

Susilawati 200101040636 
PMTK 
B 2020 

STS SS TS N SS STS S TS STS SS STS N N TS TS S TS N 

22 

2021/06/08 
8:44:02 

PM 

GMT+8 

Siti Jainap 200101040122 
PMTK 

A 2020 
STS SS N N SS STS S STS STS SS STS N N STS STS N STS SS 

23 

2021/06/08 
8:48:42 

PM 

GMT+8 

Ainun 

Asyifa 
200101040699 

PMTK 

B 2020 
TS S TS S SS TS TS TS TS SS STS S TS S STS SS STS SS 

24 

2021/06/08 

9:53:24 

PM 
GMT+8 

Imelda 
Savira 

Malik 

200101040569 
PMTK 

B 2020 
STS S N N N TS SS TS STS SS STS N S TS TS S STS SS 

25 

2021/06/09 

4:11:21 

PM 
GMT+8 

Dewi 

Desiana 

Rohmawatul 
Safitri 

200101040588 
PMTK 

B 2020 
TS N N N STS SS TS S TS N N SS TS SS N STS TS S 
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No Cap Waktu Nama NIM Kelas 
Q19 Q20 Q21 Q22 Q23 Q24 Q25 Q26 Q27 Q28 Q29 Q30 Q31 Q32 Q33 Q34 Q35 

P P N P N P N P P P P N P N P N P 

1 

2021/05/31 

1:45:40 
PM 

GMT+8 

Siti Liani 200101040756 
PMTK 
B 2020 

S N N TS S N S TS N TS N N TS N STS TS STS 

2 

2021/05/31 

2:01:13 
PM 

GMT+8 

Hafizatul 
Azmi 

200101040796 
PMTK 
B 2020 

N N S TS SS N TS S S S S TS N N TS S S 

3 

2021/05/31 
2:24:14 

PM 

GMT+8 

Nadia 

Khalifa 
200101040411 

PMTK 

A 2020 
N S S TS S N N N TS S S N N N N N N 

4 

2021/05/31 
5:14:52 

PM 

GMT+8 

Muslimatur 

Rahmah 
200101040241 

PMTK 

A 2020 
S SS N TS N N N N S SS S TS N N N N N 

5 

2021/06/08 

2:45:27 

PM 
GMT+8 

Muhammad 
Tazkiat 

Alhaytsam 

200101040635 
PMTK 

B 2020 
STS STS STS STS SS STS SS SS STS SS S TS N TS TS S STS 

6 

2021/06/08 

2:46:33 

PM 
GMT+8 

Wanda Puji 

Kusuma 

Wardani 

200101040656 
PMTK 

A 2020 
N N N TS S N N N N S S TS S TS N N N 

7 

2021/06/08 

2:47:47 
PM 

GMT+8 

Annisa Ahla 200101040779 
PMTK 
B 2020 

S S N N N N N DTD D D D TD D N N N TS 

7 

2021/06/08 
2:56:03 

PM 

GMT+8 

Zainul Gani 200101040622 
PMTK 

B 2020 
N TS N TS S TS S TS TS TS N N STS N ST\S SS STS 

8 

2021/06/08 
3:14:09 

PM 

GMT+8 

Nasrin 200101040799 
PMTK 

B 2020 
TS S S STS N S TS SS S SS S TS TS TS S TS S 
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No Cap Waktu Nama NIM Kelas 
Q19 Q20 Q21 Q22 Q23 Q24 Q25 Q26 Q27 Q28 Q29 Q30 Q31 Q32 Q33 Q34 Q35 

P P N P N P N P P P P N P N P N P 

9 

2021/06/08 

7:30:51 
PM 

GMT+8 

Nurul 
Faizah 

200101040743 
PMTK 
B 2020 

N S TS N N S TS SS S SS SS TS SS TS SS SS S 

10 

2021/06/08 

8:10:15 
PM 

GMT+8 

Zahratul 
Mahfuzah 

200101040406 
PMTK 
A 2020 

N TS S TS S N S S S S S N S TS N N N 

11 

2021/06/08 

8:11:39 

PM 

GMT+8 

Muhammad 

Ridho 
200101040396 

PMTK 

A 2020 
SS S S TS S S N TS TS S TS S S TS TS SS TS 

12 

2021/06/08 

8:13:04 

PM 
GMT+8 

Rahmatullah 200101040108 
PMTK 

A 2020 
SS STS N TS STS SS STS SS STS STS N STS STS STS SS STS STS 

13 

2021/06/08 

8:19:48 

PM 
GMT+8 

Norfujiyah 200101040210 
PMTK 

A 2020 
N N N TS N N N TS TS N N TS N N TS S TS 

14 

2021/06/08 

8:22:01 

PM 

GMT+8 

Nur 

Hasanah 
200101040175 

PMTK 

A 2020 
TS TS S TS S N N TS N S N N N N S N TS 

16 

2021/06/08 

8:24:18 
PM 

GMT+8 

Clanissia 

Suci 

Fathana 

200101040153 
PMTK 
A 2020 

N N S TS N N N S TS S S N N N S N TS 

17 

2021/06/08 
8:25:58 

PM 

GMT+8 

Norsyifa 200101040359 
PMTK 

A 2020 
N N SS TS S TS S S TS S N N N N TS S TS 

18 

2021/06/08 
8:33:25 

PM 

GMT+8 

Fitriati 200101040015 
PMTK 

A 2020 
N N N STS S N N SS SS S N N TS N N N N 

19 

2021/06/08 

8:33:49 

PM 
GMT+8 

Muhammad 
Iman 

Ansyari 

200101040279 
PMTK 

B 2020 
TS N SS TS S S N TS TS N S TS STS TS STS SS TS 
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No Cap Waktu Nama NIM Kelas 
Q19 Q20 Q21 Q22 Q23 Q24 Q25 Q26 Q27 Q28 Q29 Q30 Q31 Q32 Q33 Q34 Q35 

P P N P N P N P P P P N P N P N P 

20 

2021/06/08 

8:39:48 
PM 

GMT+8 

Sumayyah 200101040498 
PMTK 
B 2020 

N N N TS S N N S N N N N N N S TS TS 

21 

2021/06/08 

8:41:44 

PM 

GMT+8 

Susilawati 200101040636 
PMTK 

B 2020 
TS TS N STS SS N N S N N S N N N TS S STS 

22 

2021/06/08 
8:44:02 

PM 

GMT+8 

Siti Jainap 200101040122 
PMTK 

A 2020 
N N S STS SS N N TS TS N TS N TS N S TS STS 

23 

2021/06/08 
8:48:42 

PM 
GMT+8 

Ainun 

Asyifa 
200101040699 

PMTK 

B 2020 
S TS S STS S TS TS TS STS STS TS TS TS TS SS TS S 

24 

2021/06/08 

9:53:24 

PM 

GMT+8 

Imelda 
Savira 

Malik 

200101040569 
PMTK 

B 2020 
STS TS TS S SS TS S S N S N N S S SS STS N 

25 

2021/06/09 

4:11:21 
PM 

GMT+8 

Dewi 

Desiana 
Rohmawatul 

Safitri 

200101040588 
PMTK 
B 2020 

SS S N N N S TS SS TS SS SS STS N STS SS STS S 
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Lampiran 5. Hasil Uji Validitas dan Reliabilitas menggunakan Program IBM 

SPSS Statistics 22 

a. Hasil Uji Validitas 

Descriptive Statistics 

  N Minimum Maximum Mean 
Std. 

Deviation 

VAR00001 
10 1,00 2,00 1,3000 ,48305 

VAR00002 
10 2,00 3,00 2,5000 ,52705 

VAR00003 
10 2,00 5,00 3,2000 1,03280 

VAR00004 
10 2,00 4,00 3,1000 ,73786 

VAR00005 
10 1,00 4,00 2,1000 ,87560 

VAR00006 
10 3,00 5,00 3,6000 ,69921 

VAR00007 
10 2,00 3,00 2,8000 ,42164 

VAR00008 
10 2,00 5,00 3,7000 ,94868 

VAR00009 
10 1,00 3,00 1,8000 ,63246 

VAR00010 
10 1,00 4,00 1,6000 ,96609 

VAR00011 
10 1,00 3,00 1,8000 ,63246 

VAR00012 
10 2,00 4,00 3,0000 ,47140 

VAR00013 
10 3,00 4,00 3,3000 ,48305 

VAR00014 
10 2,00 4,00 2,8000 ,78881 

VAR00015 
10 1,00 4,00 2,4000 ,84327 

VAR00016 
10 1,00 3,00 2,4000 ,69921 

VAR00017 
10 1,00 3,00 2,4000 ,84327 

VAR00018 
10 1,00 3,00 1,8000 ,78881 

VAR00019 
10 2,00 4,00 3,0000 ,66667 

VAR00020 
10 2,00 5,00 3,4000 ,84327 
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  N Minimum Maximum Mean 
Std. 

Deviation 

VAR00021 
10 1,00 3,00 2,5000 ,70711 

VAR00022 
10 2,00 3,00 2,2000 ,42164 

VAR00023 
10 2,00 3,00 2,6000 ,51640 

VAR00024 
10 2,00 4,00 3,1000 ,56765 

VAR00025 
10 2,00 4,00 2,9000 ,56765 

VAR00026 
10 2,00 4,00 3,0000 ,81650 

VAR00027 
10 2,00 4,00 3,0000 ,81650 

VAR00028 
10 3,00 5,00 4,0000 ,66667 

VAR00029 
10 3,00 5,00 3,8000 ,78881 

VAR00030 
10 3,00 4,00 3,5000 ,52705 

VAR00031 
10 3,00 5,00 3,2000 ,63246 

VAR00032 
10 3,00 4,00 3,2000 ,42164 

VAR00033 
10 2,00 4,00 2,8000 ,63246 

VAR00034 
10 2,00 3,00 2,7000 ,48305 

VAR00035 
10 1,00 3,00 2,5000 ,70711 

SKOR 10 82,00 109,00 97,0000 9,54521 

Valid N 
(listwise) 10         

 

b. Hasil Uji Reliabilitas 

Reliability Statistics 

Cronbach's 

Alpha N of Items 

,838 35 
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Lampiran 6. Hasil Uji Frequency menggunakan Program IBM SPSS Statistics 22 

KATEGORI 

 Frequency Percent Valid Percent 

Cumulative 

Percent 

Valid 1,00 8 32,0 32,0 32,0 

2,00 15 60,0 60,0 92,0 

3,00 2 8,0 8,0 100,0 

Total 25 100,0 100,0  
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Lampiran 7. Perhitungan Skor Ideal 

 Item Soal : 35 

 Skala : 1-5 

 Skor Minimum 

         

 Skor Maksimum 

          

 Mean Ideal 

 

 
(                          )  

 

 
(      )  

 

 
(   )       

 Standar Deviasi 

 

 
(      )  

 

 
(   )        

 Batas Minimum 

        

            

        

 Batas Tengah 

             

              

 Batas Maksimal 
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Lampiran 8. Langkah Perhitungan Menggunakan SPSS 

a. Perhitungan Uji Validitas Statistik Deskriptif 

 Masukkan data angket 

 Pilih Analyze => Descriptive Statistics => Descriptives 

 Ctrl A semua Variable pindahkan ke kolom Variable(s) kemudian OK 
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b. Perhitungan Uji Reliabilitas 

 Masukkan data angket, pilih variable view dipojok kiri 

 Ubah Decimal menjadi “0” dan measure menjadi “Scale” 

 Kembali ke Data View dan pilih Analyze => Scale => Reliability Analysis 

 Pindahkan semua variable ke kolom Item, kemudian pilih Statistics 

 Pilih Scale if item deleted => Continue lalu OK 
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c. Perhitungan Frequency  

 Masukkan data angket 

 Pilih Transform => Recode into Diffrent Variables 

 Pilih Numeric Variable Total, kemudian masukkan Output variable 

menjadi Kategori => Change => Old and New Values 

 Masukkan data Value => Continue => OK 

 Klik 2x kategori 

 Pilih Values, kemudian masukkan Value dan Label => Add => OK 

 Pilih Descriptive => Frequencies 

 Pilih Variable Kategori => OK 
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Lampiran 9. Dokumentasi 

a. Gedung Pendidikan Matematika 

  

b. Ruang Perkuliahan 

 

c. Perkuliahan Mata Kuliah Kalkulus Integral via Youtube 
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Lampiran 10. Jadwal Perkuliahan Program Studi Pendidikan Matematika 

angkatan 2020 

a. Pendidikan Matematika Kelas A 2020 

 

b. Pendidikan Matematika Kelas B 2020 
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Lampiran 11. Surat Persetujuan Judul Skripsi 
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Lampiran 12. Surat Keputusan Penetapan Dosen Pembimbing Skripsi 
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Lampiran 13. Catatan Seminar Desain Operasional Skripsi 
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Lampiran 14. Surat Keterangan Selesai Seminar Desain Operasional Skripsi 
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Lampiran 15. Surat Persetujuan Pelaksanaan Riset oleh Dosen Pembimbing 
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Lampiran 16. Surat Riset 
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Lampiran 17. Surat Rekomendasi 
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Lampiran 18. Surat Izin Riset 

a. Dekan Fakultas Tarbiyah dan Keguruan UIN Antasari Banjarmasin 
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b. Ketua Jurusan Pendidikan Matematika 
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Lampiran 19. Surat Uji Validitas 
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Lampiran 20. Lembar Validasi Angket 

a. Ahli Psikologi 
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b. Ahli Matematika 
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Lampiran 21. Surat Selesai Riset 
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Lampiran 22. Catatan Bimbingan Skrispi 

a. Bidang Konten dan Metodologi 

No Hari/Tanggal 
Konsul 

ke- 
Catatan 

    

 

b. Bidang Bahasa & Teknik Penulisan 

No Hari/Tanggal 
Konsul 

ke- 
Catatan 

1. Senin, 15 Maret 

2021 

1 - 

2. Rabu, 31 Maret 2021 2 - 

3. Rabu, 21 April 2021 3 1. Menurut ibu perlu indikatornya juga 

kesulitan belajar itu, untuk 

memudahkan kamu dalam mengambil 

data. 

2. Biar jelas nanti dalam pembuatan 

angketnya,mengacu ke indikator 

kesulitan belajar dan kecemasan itu. 

4. Selasa, 27 April 

2021 

4 - 

5. Senin, 19 Juli 2021 5 1. Ambil logo uin dari website resmi uin 

yang ada tulisannya antasari 

banjarmasin. 

2. Abstrak cukup dibuat 3 paragraf saja, 

paragraf 1 tujuan, paragraf 2 metode 

penelitian, paragraf 3 nanti hasil 

penelitian. 

3. Jarak antar footnote 1 spasi saja. 

4. 1 paragraf minimal terdiri dari 2 

kalimat. 

5. Cek bagaimana penulisan kutipan 

langsung pada pedoman, apakah 

letaknya mengikuti paragraf di atas 

atau menjorok ke dalam seperti ini. 

6. Dimiringkan. 

7. Tidak usah disebutkan nama lengkap, 

tahun dan judul penelitian orang lain, 

cukup sebutkan nama dan hasil 

penelitiannya, perbedaannya dengan 

penelitian kamu, kemudian di 

footnote kan saja. 

8. Konsisten kan penggunaan peserta 

didik atau siswa. 
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No Hari/Tanggal 
Konsul 

ke- 
Catatan 

   9. Cek penomoran footnote, jika lanjut 

ke bab selanjutnya apakah no.nya 

dilanjutkan dari no.footnote di bab 

sebelumnya atau diulang lagi no,1 

seperti ini. 

10. Jaraknya terlalu jauh. 

11. Perbaiki penamaan tabel, lihat buku 

pedoman. 

12. Tabelnya ditulis di hal.selanjutnya 

saja agar tidak terpisah seperti ini. 

13. Untuk materi, jangan diambil dari 

skripsi orang, ambil dari beberapa 

buku, kalo perlu ambil dari buku di 

mata kuliah integral. 

14. Terlalu jauh jaraknya. 

15. Saran-saran. 

16. Cek bagaimana penulisan Al-Qur’an 

pada daftar pustaka. 

17. Spasi pada daftar pustaka cek lagi 

pada buku pedoman. 

6. Rabu, 15 September 

2021 

6 1. Ini di tandatangani. 

2. Harus di ttd juga. 

3. Sebutkan kepala perpustakaan UIN 

Antasari. 

4. Footnotenya mana? 

5. Ini menurut Bloom atau Uno? Kalau 

menurut Bloom, car referensi aslinya. 

6. Ini di enter ke hal.berikutnya saja. 

7. Mmotovasi > motivasi. 

8. Enter ke bawah saja. 

9. Pada penelitian ini menggunakan 

triangulasi apa? 

10. Spasi dalam tabel 1 spasi, letak tabel 

di mana? Di kiri atau di tengah? 

11. Perbaiki singkatan-singkatan 

perguruan tinggi. 

12. Kata depan yang menunjukkan 

tempat dipisah. 

13. Dijelaskan 5W+1H itu apa saja. 

14. Daftar pustaka dulu baru lampiran. 

15. Di lampiran, masukkan juga lembar 

bimbingan dengan dosen 

pembimbing. 
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